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Getting a Picture Into Elements

Photoshop Elements is a photo editing software application. Although you can
create very simple graphics using only Elements tools, it is much more common
to use Elements to edit photographs. In order to edit these photographs, they
need to be digitized into your computer. There are several ways to get a
photograph into the computer. Among the most popular ways are:

• Scanning an existing photograph
• Using a digital camera to take the picture
• Obtaining a photograph from a clip art collection
• Having existing photographs put onto a Kodak PhotoCD at the store, and

using those digitized photos

Scanning Photos
Although this workshop is about Photoshop Elements and we are not going to be
scanning photos, I do want to mention some tips about scanning. All scanners
come with some sort of software that allows you to scan pictures. Each scanner
manufacturer’s software works a little differently. Sometimes there is a plug-in
that allows you to scan directly from Elements; sometimes you have to scan your
picture before opening it in Elements.

Photographs vs Printed Pictures
Pictures that are taken by a film camera, developed, and set onto a piece of
photography paper are photographs. Pictures that are printed in a magazine,
flyer, newspaper, etc. are copies of photographs. Sometimes when you scan
printed materials, they have a noticable grainy pattern. When you scan, you can
adjust the settings to minimize this grainy pattern.

Black & White vs Color Photos
If your photograph is in color, scan it in Color-RGB. If the photograph is black
and white, scan it either in Color-RGB or Grayscale. If you scan a color photo as
Grayscale, it will turn out in shades of black, white and gray. If you want to
change your color photo to gray, you can do that inside Elements.

Web vs Printed Output
It is a good idea to know what you want to use the picture for before you scan. If
your output will be for the web or e-mail, you can scan at a resolution of 72 dpi.
If the output will be for print, you’ll want more detail. Scan at 300 dpi if you’ll be
printing to a laser printer. However, the higher quality (dpi) the scan, the larger
the file size will be.

If you’re not sure what you’ll be using the scan for, scan at 300 dpi. You can more
acceptably make a file smaller than larger.
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Getting Started

Double-click on the Photoshop Elements 2 icon to launch
the program. A Welcome Screen will open up, from which
you can choose what activity you’d like to do: open a new
file, browse to find and open an existing file, connect to a
camera or scanner, or run the tutorial.

+ For this activity, double-click on the Browse for File option.

The File Browser dialog box appears. In
the box at the upper left, identify the
folder containing the existing file you’d
like to open. At the left, small
thumbnails of all the photos in that
folder appear. You simply double-click
on the file you want to work with.

+ Find the folder called Elements Class. From inside that folder, double-click
on the file called flower.jpg.

This is a picture of a yellow hibiscus
flower with a red center and a dark
background behind it.

As you can see by the rulers at the edges,
(View Í Rulers), the photograph is
approximately 9” x 6.7”. It looks very
nice on the monitor, with no jaggedy
edges.

But monitors only show 72-95 pixels per
inch. This picture may or may not print
out nicely. Let’s find out.
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A Little Resolution

As you can see from the picture we opened, flower.jpg, it is nearly 9” x 6.7”.
What does that mean when it’s sent via e-mail? How about printing?

Image Size

+ From the Image Menu, drag down to Resize and then
over to Image Size…

The dialog box that appears is full
of information. Notice at the top,
the Pixel Dimensions are 640 pixels
wide and 480 pixels high.

The Document Size is 8.889” wide
by 6.667 inches high. The resolution
is 72 pixels per inch.

What this means is that the picture
is a bit large for putting onto a web
page, but the quality of it printed
would be low. We’ll want to adjust
it for either purpose.

Changing the Resolution for Print

As mentioned before, images that will be printed on a laser printer look best if
the resolution is set at 300 ppi or greater. If you’re printing to a color inkjet
printer, somewhere around 200-300 ppi is usually acceptable. Our flower picture
is only 72 ppi. In the Image Size box, there is a category called resolution, which
currently reads 72 ppi. In the same area, notice that there is a link between the
Width and Height, but no link to the resolution.

With the current settings, if you click in the Resolution: box and type 300, then
the width and height will remain the same (~9” x 6.7”). That would give us an
very large (memory-wise) file but the quality still wouldn’t be good, because this
is “resampling up”. Elements has to “guess” what each of the new pixels should
look like. if you were to close the Image Size box, you’d notice that the picture
has increased enormously in size, but the edges look jagged.
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Don’t Resample Up!

So, what you need to do to create an acceptable print is to click OFF the
Resample Image box at the bottom of the dialog box. That forces the Width,
Height and Resolution to all be linked. When you change one, they will all
change.

In the example above, notice that the Resample Image box is unchecked. When
the resolution is changed from 72 ppi to 300 ppi, notice that the size changes to
2.133” x 1.6”. But look at the Pixel Dimensions. They remain at 640p x 480p. This
will result in an acceptable print.

If you want your print larger, you can play around with the settings a little.
Recheck the Resample Image to unlink the resolution, then try a little bit bigger
width and height settings, but don’t go too far. If you scanned your photo, it is
better to rescan at a higher resolution than to resample up.

+ After playing around with the settings to see how changing one thing affects
other things, click on the Cancel button to return to the original size and
resolution.
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Changing the Resolution for Web or E-mail

Images that are loaded onto web pages, or sent via e-mail need to be as small in
file size as possible. (File size is amount of space in memory they take up, not
how physically large they are.) Computer monitors only show 72-95 ppi, so if a
picture has a larger ppi setting, all that extra memory used doesn’t look any
better. Also, pictures should be small enough to fit onto a monitor screen without
the user having to scroll back and forth to see the entire picture.

Our flower.jpg photo is already 72 ppi, which is ideal for internet use. But it is
very large in size: ~9” wide. So we want to make our picture smaller without
changing the resolution, which will create a smaller file size.

+ Be sure the Resample Image box is checked. Then set your width or height
to a size you think is appropriate for your web page or e-mail. After you’ve
changed the document size settings, notice that the Pixel Dimensions
settings are much smaller, as well as the file size.

TIP
Be aware that when you adjust the pictures of your children as
described above and send them to your parents so they can see how
cute they are, these pictures will look great on the monitor but won’t
look all that great when printed out. That’s because they are only 72
ppi. However, if you don’t adjust them, then it can take forever for the
pictures to download on their 56k modems.
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Saving Files

Once you have a document and have adjusted it to the correct size for your
purposes, you need to save it. Even if you plan to work on it some more, you
should save the original, untouched photo so that you can come back to it in case
later on you make changes you don’t like.

+ To save, choose Save or Save As from the File Menu. Since this document
has already been saved once, we’ll need to choose Save As to give it a
different name.

As you can see from the box on the right, there are many
different formats in which to save your document. Some
you’ll never use; others you will use a lot.

The current document is in .jpg format. This is a very
commonly used format for photos that will go onto web
pages or be sent via e-mail. However, it is not the best
format for our use.

We will be adjusting our photo and playing around with it. The best format to
save this document in while we’re playing around with it is the Photoshop
format.

+ From the Format list, choose Photoshop. Notice that
the .pdf suffix is automatically appended to the title
you type in. Don’t delete that suffix. Be sure you know
where you’re saving the document . . . save it into the
Elements Class folder. Then click on the Save button.
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Save Formats

Photoshop This format is ideal for files you’re still working on. It doesn’t
compress the file, and it allows multiple layers. However, many
programs, such as Word, don’t allow you to import .psd files, so
when you’re done working on the photo, you’ll need to switch to a
different format.

JPEG JPEG is the best format for saving photographs for the web or e-
mail. Word will also import jpegs. However, this format is lossy…
which means that every time you save a document in this format,
information is lost. The first time you save a file as a .jpeg it looks
fine. If you repeatedly open the file and make changes and save
again, more and more information is lost and pretty soon your file
looks bad. For this reason, it’s a good idea to save the original
photoshop version of a .jpeg file, also, so you can make changes to
it and resave.

GIF The CompuServe GIF format is great for clip art images that will
be used on the web. Since they have a limit of 256 colors, this
format is not the best for photographs. However, you can create
logos with transparent backgrounds when you save in .gif format.

TIFF TIFF format is a good choice for photographs that will be printed.
Word can import TIFF files, but this format won’t work for web
graphics. The TIFF format is not lossy, so information is not lost
when opening and resaving files. However, files can be very large.

BMP This is a common format for Windows computers.
PICT This is a common format for Macintosh computers. I’ve heard

rumors that this older format will be going away in the not-too-
distant future.

There are many other file formats, but the ones listed above are the most
common.
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Enhance the Flower Photo

Here comes the fun stuff! Now that we’ve saved our flower as a photoshop
document, we’re going to make some changes to it. This will not affect our
original flower.jpg document.

Elements is very, very similar to Photoshop. There are a few advanced features
in Photoshop that are used mostly by professional graphic designers. That means
that you have lots of ways to manipulate your photo. Some are just a click of a
button. Some you’ll have to work at a little. So let’s get started with some of the
easy ones!

Quick Fix…
The Quick Fix dialog box allows you to adjust your images, and presents you
with instant feedback.

There is a “before” picture and an “After” picture. Some of the types of
ajustments you can do in Quick Fix… include changing the brightness, adjusting
the color and sharpness, and rotating the image.

Also note the Undo, Redo and Reset Image buttons on the right. Use Undo to
cancel your last change. Use Reset Image if you’ve made several changes and
want to undo all of them.
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+ From the Enhance Menu, choose Quick Fix… Select any category and then
select the adjustment. Apply the change and look at the results in the “After”
window. Then click on the Undo button and try something else. Check out all
the categories.

+ My absolute favorite quick fix is color correction. Although you can’t tell from
this black and white handout, I’ve changed the color of the hibiscus from
yellow to a very nice peach by simply sliding the hue and saturation levels.
You need to be careful, though, or you’ll end up with some “out-of-this-world”
results.

+ When you’re done investigating all the Quick Fix options, click on the Reset
Image button so that the image returns to the way it was before we made
any changes, and click OK. We’ll make other changes using tools which
aren’t so limited.

Selecting a Portion the Image
We want to make changes to the flower but not the background. To do so, we’ll
select only the flower. To make our selection we’ll use two tool: the Magic Wand
Tool and the Lasso Tool.
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+ Click on the Magic Wand Tool (second tool down on right side of Tools
Palette. Notice that the Ojbect Palette now reflects options relating to the
Magic Wand.

The Magic Wand allows you to make a selection based on the color of the pixel
you click on. The Tolerance: box allows you to narrow or widen the selection: if
the tolerance is set to 0, then the only pixels selected will be those that are exactly
the same color as the one you click on; a tolerance of 50 means that the selection
will include pixels that are close in color to the one you click on, but maybe not
exactly that same color.

+ The default for Tolerance is 32. That is acceptable for us, so leave it.
If the Contiguous box is checked, then only pixels that are physically next to the
pixel clicked on will be selected; if the box is not checked, then pixels of the
correct color that are located anywhere in the picture will be selected.

+ The default is the Contiguous box is checked. Click in that box to turn it off.

+ With the Magic Wand Tool selected, click on the flower.Only part of the
flower will be selected. You’ll see what is selected because it will have
“marching ants” around selected parts.

+ Hold down the Shift Key (on the keyboard) and click on another, unselected
portion of the flower. Continue holding down the Shift Key and clicking on
unselected portions until most of the flower
is selected.

+ Switch to the Lasso Tool. Keeping the Shift
Key depressed, draw a  circle around areas
that are not selected inside the flower until
the entire flower is selected.

+ If you accidentally selected areas outside
the flower, you’ll need to delete those
areas. Hold down the Options key (Mac)/Alt
key(PC) and drag the lasso around those
areas you want to deselect.
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Once the flower is selected, we can make changes to it, but it would be better to
save this selection so that we don’t have to work so hard to choose it again.

+ From the Select Menu,
choose Save Selection. Give
your selection a name (such
as “flower”, and click the OK
button.

Layers
All Elements documents have at least one layer. When you create a new image,
scan an image, or open one taken by a digital camera, there is only one layer. But
as you work with your image, you may want to create new layers.

Layers give you the freedom to rearrange your image, adjust its color and
brightness, apply special effects, edit, and add new elements to your image. With
layers, all these things can be done without making permanent changes to your
original image and without affecting other layers.

When you create, import, or scan an image in Photoshop Elements, the image
consists of a single layer. If you're retouching the image, you can edit the original
layer to make permanent changes. Alternatively, you can leave the original layer
intact as a backup, and retouch a duplicate copy of the layer. We’ll make a copy
of our background to edit.

The Layers Palette can be found in the Dock at the upper right of the Window. I
prefer to drag it out of the Dock, which leaves it open on the Desktop.

+ When you open the Layers Palette, the only
layer is the Background. We want an identical
layer, so click on the More button at the upper
right corner. Drag down to Duplicate Layer. You
can give it a name if you want. I usually don’t.

In the Layers Palette, you’ll see eyeball icons in the
left-most column. If the eyeball is showing, then that
layer will show in the picture. If you click on the
eyeball, it will close and that layer won’t appear in
your picture.
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+ On the Background Layer, click on the eyeball to turn off that layer.

Now we want to adjust the flower on the Background Copy layer. We want to
keep the flower but delete the dark green background. The Flower Selection we
made earlier will help us here.

+ From the Select Menu, choose Load Selection. The only selection that’s
been saved is flower, so click OK. The flower is selected. We want to delete
the background, not the flower, so from the Select Menu, choose Inverse,
which will select the background.

+ Click the Delete Key on the keyboard to remove the dark background,
leaving the flower.

+ Move the flower over to the left with the Move Tool (Upper Right Arrow on
Toolbar)

Earlier, we used Quick Fix… to recolor the flower.
But when you use that tool, it changes the color of
the entire picture. In this case, we want to change
the color of the flower petals without affecting the
white and red flower center. To do so, we’ll use the
Replace Color… feature, which is found under the
Enhance Menu Í Adjust Color.

+ When you open the Replace Color dialog box,
your cursor changes into an eyedropper. Click
on the flower petals.

+ Drag the Fuzziness: slider in the Replace
Color dialog box to the right to increase the
amount of petal you want to recolor.

+ In the bottom part of the dialog box, drag the Hue slider to change the color
of the petals. Drag the Saturation slider around to make the color more or
less vibrant. Notice that although the colors of the petals change, the center
colors are not affected. When you’re satisfied, click OK.

Now our flower picture has two flowers: the original on the Background layer,
and the new, recolored flower on the new layer. The background layer is still
turned off so you don’t see it.
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+ To turn on the background layer, click in the empty left-most box on the
Background Layer in the Layers palette. The eyeball will reappear in the
palette and the flower will reappear on our image.

These two flowers are the same size and same rotation. I think it would look
better if the new flower were resized smaller and rotated some.

+ Be sure the Copy Layer is the active layer (it will be colored in the Layers
Palette. To transform the flower, choose Image Í Transform Í Free
Transform.

+ A faint box appears around your flower, with selection boxes in the corners
and edges. To resize the flower, place your cursor on one of the corner
boxes, hold down your mouse button and drag in or out to make the flower
smaller or larger. Let go of the moue button.

+ To rotate the picture, move your cursor outside of the faint selection box and
towards a corner. The cursor turns into a double-headed 90° arrow. Just
hold down the mouse button and drag it around. The flower will rotate.

+ Use the Move Too to move the flower to a new position.

+ Just for fun, create another flower layer and adjust it, too! If you want the
original picture to be in front of one of the others, make a new duplicate layer
of the background, delete the background color, and move that flower up in
the list of layers.

+ You can save this photo as-is in Photoshop format, but if you’re done
adjusting the photo and want to use it in another program, you’ll need to
flatten the layers first. In the Layers Palette, click on the More button and
drag down to Flatten Layers. Then you can save for web or print use.
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MANIPULATING DIGITAL IMAGES

Example 1: Parachute with Fireworks Background

1) From the File Browser open the Fireworks picture and the Parachute
picture. Close the File Browser so you can see both pictures at once.

2) Check the image size and resolution for both pictures. Image Í Resize Í
Image Size…) Write down the width, height, and resolutions. Be sure these
settings are the same as for the both pictures.

(If you want to merge two pictures but they don’t have the same resolution,
then they won’t retain the expected size ratio.)

3) Align the two pictures side-by-side (as much as possible on monitor).

4) Click on the Parachute picture to make it active, if necessary.

5) Click on the Magic Wand tool.   Change the Tolerance to 10 and turn off
Contigous if it is checked. Click on any part of the blue sky using the Magic
Wand. A portion of the sky will become selected. Hold down the Shift key
and click an unselected area of sky to add more to the selection. Hit the
delete key to remove it, leaving a transparent background. Continue in this
manner, selecting blue sky and deleting it.

The Zoom tool can be used to magnify an area–especially useful around the
parachutist. To zoom out when you’re done, hold down the option key on
the keyboard while using the Zoom tool.

6) Once the blue sky is deleted, select the entire picture (z/Control-A) and
copy it (z/Control-C).

7) Click on the open Fireworks document. Paste the parachute ((z/Control-
V).

The parachute picture will appear in front of the fireworks display. You can

move the parachute around by clicking on the Move tool  and
dragging it around. The parachute is on a different layer than the fireworks.
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Example 2: Creating a Herd of Llamas

1) Open both the llama front and llama side pictures and arrange them side-
by-side. (File Browser can be found under the Window menu.)

2) Click on the Clone tool. 

3) Hold down the Option/Alt key on the keyboard and click once on the
sideways llama. Release the Option/Alt key. This loads the clone tool with
what we want to clone.

4) Click in the grass on the llama front picture. Hold down the mouse and
drag it around. As you drag, you’ll notice that a picture of the side llama is
being copied onto the other picture.

It is also possible to clone inside the same picture using the above
procedure. Try cloning a whole herd of llamas.

Example 3: Adjusting a Scanned Picture

For our next example, open the library document (located in the examples
folder). This is a scanned slide of the Foothill library, and is in need of
adjustment.

1) There is a line of black pixels at the very top right corner of the slide that
should be cropped out.

a) Click on the Rectangular Marquee tool  .
b) Place the cursor in the upper right corner of the picture under the black

line.
c) Hold down the mouse and drag over to the lower left corner. This

selects the area we want to keep. The area outside the box will be
cropped away.

d) From the Image menu, select crop.

2) In the blue sky above the library on the left side, there are some black dots.
If they bother you, you can get rid of them by cloning another area of blue
sky. It’s up to you.

3) To improve the brightness and contrast, we’ll adjust the levels.
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Choose Enhance Í Adjust
Brightness/Contrast Í Levels…

In the dialog box, move the left
input slider towards the right to
where the graph has a noticeable
lump. That darkens the picture.

Next, move the middle input slider
towards the left to lighten the
building. Click OK when you’re
satisfied.

Images acquired through a digital camera or by scanning often can be improved
by making the edges appear sharper. To do this, use the Unsharp Mask filter.

5) Choose Filter Í Sharpen Í Unsharp Mask…
• The Amount field determines how much contrast there is between dark

and light areas (1%-480%).
• The Radius field determines how far from the border to which contrast

applies (1.5 or less is normal).
• The Threshold field describes how much contrast must be present

before sharpening will be applied.

Suggested Starting Values for the Unsharp Mask Filter
Amount (%) Radius (Pixels) Threshold

50 0.7 0
75 0.8 - 1 0
100 1 - 1.1 0
125 1.1 - 1.2 0
150 1.2 0
175 1.3 0
200 1.5 1

200+ Not recommended

Table from The Complete Idiot’s Guide to Digital Photography by Steven Greenberg, page 224.
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For our picture, select some values (using the recommendations in the table
above) and click the preview box on and off to see what the effect will be.
When you’re satisfied, click the OK button for the changes to take effect.

6) The picture is now looking pretty good. Let’s see how big it is and what
resolution it is set at.

Choose Image Í Resize Í Image
Size….

The slide was scanned at a resolution of
120 pixels/inch. It is 10 inches wide by
6.667 inches high. (Your picture may
have slightly different values depending
on how much you cropped off in Step
1). This is a perfect size to place the
picture onto a PowerPoint slide. The
resolution is also fine for use on a
computer (for projecting your slides in a
presentation). You should lower the resolution to 72 pixels/inch if you’re
going to put it on a web page.

If you want to print out this picture, the resolution is not enough to provide
a good copy. You will want to change the resolution to at least 240, or
preferably 300 pixels per inch. Be sure Resample Image is NOT checked!
Then click in the Resolution box and typing in a new figure. You’ll notice
that when you do so, the width and height amounts get correspondingly
smaller.

For now, we’ll leave it at that.

7) Right now your photograph is in PhotoShop format. That is a good format
for working on the photo, but in order to use it in another program, you’ll
probably need to save it in a different format.

Choose File Í Save As…. You have quite a choice of formats to
save your photo in, as seen when you click on the Format: button.

If you’ll be using your photo on a web page, save it in JPEG format.
Use the .jpg suffix at the end of the name. Also, if you’ll be using it
on a web page, set the resolution at 72 pixels/inch. Anything more
is a waste of memory and causes it to load slowly.
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If you’ll be using your photo in a MS Word document, you can save it in
PICT, TIFF, or JPEG formats. I don’t want to get into the pros and cons of
different formats here, but there are advantages and disadvantages of each
format.

When you save a photo in JPEG
format, another dialog box crops up
inquiring about the quality desired.
You can choose what you want. If
you’re unsure, save the document in
Low, Medium, High, and Maximum
quality and see for yourself if there is a
noticeable drop in quality. Use the
lowest quality acceptable for the
smallest file size. This is especially
important for web pages. For use in
PowerPoint or MS Word, save in High
quality or better.

On Your Own

Now it’s time for you to experiment with some digital camera or scanned images
on your own. In the Elements Class folder there several photos we haven’t
played with yet. Use any or all of these photos to manipulate and play with. If
you don’t like the results, choose Edit Í Undo

Some suggestions:

• Try posterizing (Image Í Adjust Í Posterize)
• Try any or all of the filters available under the Filter menu
• Try selecting a portion of a picture and pasting it into a new document
• Try pasting portions of several pictures into one new document
• Try adding text to your photo

We’ll be covering many of these options plus more at our next class.

A Note About Printing to Inkjet Printers
Epson recommends an image resolution of no more than 1/3 the resolution
of the ink-jet printer. So a graphic printed on a 720 dpi ink-jet printer
doesn’t need a resolution higher than 240 ppi. This includes line art,
grayscale, and color images.

(Because ink is wet and tends to spread)
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Photoshop Elements
Resolution
Image Size
Layers
Filters
Print vs. Web
quick fix tools
saving formats
panoramas

sites to be aware of:
www.Kodak.com/US/en/digital/dlc/book3/chapter5
www.photographytips.com/page.cfm/441
www.shortcourses.com
www.adobe.com/support/forums/main.html


